When exported from Japan, this manual does not require application to the Ministry of International Trade and Industry for service transaction permission.

Specifications subject to change without notice.
Revisions

*The manual number is noted at the lower left of the back cover.

<table>
<thead>
<tr>
<th>Print Date</th>
<th><em>Manual Number</em></th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sep., 1997</td>
<td>IB(NA)-66795-A</td>
<td>First printing</td>
</tr>
<tr>
<td>Feb., 1998</td>
<td>IB(NA)-66795-B</td>
<td>Partial correction</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 2.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Partial addition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 4.2</td>
</tr>
<tr>
<td>Jun., 2004</td>
<td>IB(NA)-66795-C</td>
<td>Partial correction</td>
</tr>
<tr>
<td></td>
<td></td>
<td>About the Manuals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Addition</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WARRANTY</td>
</tr>
</tbody>
</table>

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

© 1997 Mitsubishi Electric Corporation
# Introduction

Thank you for purchasing the Mitsubishi Graphic Operation Terminal.
Before using the equipment, please read this manual carefully to develop full familiarity with the functions and performance of the graphic operation terminal you have purchased, so as to ensure correct use.
Please forward a copy of this manual to the end user.

## Contents

1. **Overview**
   1.1 Features ................................................. 1 - 1
   1.2 Structure and Guide to the Use of This Manual ............... 1 - 3
   1.3 Abbreviations and Symbols Used in this Manual ............... 1 - 5

2. **Where to Start**
   2.1 Information Required before Setting the Report Function ....... 2 - 1
   2.2 Report Creating Procedure Outline ................................ 2 - 6
   2.3 Startup of the Report Software .................................... 2 - 7

3. **Creating Data**
   3.1 Creating New Report Project Data .................................. 3 - 1
   3.2 Creating the Next Report Project Data/Opening the Report Project Data to Be Edited .......... 3 - 2
   3.3 Overlapping or Tiling the Open Report Windows ....................... 3 - 3
   3.4 Closing the Report Window on the Application Window ............ 3 - 4
   3.5 Storing the Report Project Data on Hard Disk or Floppy Disk .... 3 - 5
   3.6 Opening the Report Project Data Stored on Hard Disk or Floppy Disk ................. 3 - 7
   3.7 Copying the Report Project Data from Another Project ............ 3 - 8

4. **What to Do First**
   4.1 PC Type Setting ............................................. 4 - 1
   4.2 Common Setting .............................................. 4 - 2
   4.3 Setting the Operation Environment for the Report Software .... 4 - 4
   4.4 Setting the Display Environment for the Report Software ........ 4 - 5
   4.5 Setting the Report Title ....................................... 4 - 6
   4.6 Setting the Parameters ......................................... 4 - 7
   4.6.1 Selecting Real-Time Continuous Type ............................ 4 - 7
   4.6.2 Selecting the Logging Page-Renewed Type ....................... 4 - 8

5. **Creating Canvas Data**
   5.1 Drawing Rules ............................................... 5 - 1
   5.2 Entering Text ................................................ 5 - 2
<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>6. Setting the Print Allocation Data</td>
<td>6-1 to 6-4</td>
</tr>
<tr>
<td>6.1 Print Allocation Setting for Numerical Data</td>
<td>6 - 1</td>
</tr>
<tr>
<td>6.2 Print Allocation Setting for Comment Data</td>
<td>6 - 3</td>
</tr>
<tr>
<td>7. Setting the Header and Repeated Lines</td>
<td>7-1 to 7-4</td>
</tr>
<tr>
<td>7.1 Specifying the Header and Repeated Lines</td>
<td>7 - 1</td>
</tr>
<tr>
<td>7.2 Resetting or Changing the Header</td>
<td>7 - 4</td>
</tr>
<tr>
<td>7.3 Changing the Repeated Lines</td>
<td>7 - 4</td>
</tr>
<tr>
<td>8. Editing the Report Data and Print Allocation Data Created</td>
<td>8-1 to 8-8</td>
</tr>
<tr>
<td>8.1 Correcting the Rules or Characters</td>
<td>8 - 1</td>
</tr>
<tr>
<td>8.2 Editing the Rules or Characters</td>
<td>8 - 3</td>
</tr>
<tr>
<td>8.3 Editing the Print Allocation Data</td>
<td>8 - 6</td>
</tr>
<tr>
<td>9. Editing the Report Project Data Created</td>
<td>9-1 to 9-3</td>
</tr>
<tr>
<td>9.1 Copying the Created Report Data to Another Report Number</td>
<td>9 - 1</td>
</tr>
<tr>
<td>9.2 Deleting the Created Report Data on a Report Number Basis</td>
<td>9 - 2</td>
</tr>
<tr>
<td>9.3 Changing the Report Number of the Report Data Created</td>
<td>9 - 3</td>
</tr>
<tr>
<td>10. Downloading/Uploading</td>
<td>10-1 to 10-3</td>
</tr>
<tr>
<td>10.1 Downloading the Report Project Data</td>
<td>10 - 1</td>
</tr>
<tr>
<td>10.2 Uploading the Report Project Data</td>
<td>10 - 3</td>
</tr>
<tr>
<td>11. Confirming the Report Project Data</td>
<td>11-1 to 11-2</td>
</tr>
<tr>
<td>11.1 Confirming the Report Project Data Stored on Onboard Memory</td>
<td>11 - 1</td>
</tr>
<tr>
<td>11.2 Confirming the Report Project Data Stored on Memory Card</td>
<td>11 - 2</td>
</tr>
</tbody>
</table>
## About the Manuals

The following product manuals are available. Please use this table as a reference to request the appropriate manual as necessary.

### Related Manuals

<table>
<thead>
<tr>
<th>Manual Name</th>
<th>Manual No. (Model Code)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A870GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66628 (1DM050)</td>
</tr>
<tr>
<td>This manual describes the specifications and performance of the A870GOT main unit as well as the hardware configuration, procedures for installing optional units, operation in off-line mode, error codes, and troubleshooting guidelines.</td>
<td></td>
</tr>
<tr>
<td>A850GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66669 (1DM038)</td>
</tr>
<tr>
<td>This manual describes the specifications and performance of the A850GOT main unit as well as the hardware configuration, procedures for installing optional units, operation in off-line mode, error codes, and troubleshooting guidelines.</td>
<td></td>
</tr>
<tr>
<td>A852GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66767 (1DM042)</td>
</tr>
<tr>
<td>This manual describes the specifications and performance of the A852GOT main unit as well as the hardware configuration, procedures for installing optional units, operation in off-line mode, error codes, and troubleshooting guidelines.</td>
<td></td>
</tr>
<tr>
<td>A853GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66785 (1DM044)</td>
</tr>
<tr>
<td>This manual describes the specifications and performance of the A853GOT main unit as well as the hardware configuration, procedures for installing optional units, operation in off-line mode, error codes, and troubleshooting guidelines.</td>
<td></td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual</td>
<td>IB-66792 (1DM177)</td>
</tr>
<tr>
<td>(Introductory Manual)</td>
<td></td>
</tr>
<tr>
<td>This manual is designed for the first-time user of the GOT. It describes how to create monitor screens with the A8GOTP, how to send monitor data to the GOT, and what the various screen displays mean.</td>
<td></td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual</td>
<td>IB-66791 (1DM179)</td>
</tr>
<tr>
<td>(Startup Manual)</td>
<td></td>
</tr>
<tr>
<td>This manual describes the configuration of the A8GOTP system, precautions for the configuration, and the specifications of the various functions, as well as the installation procedures, startup procedures, screen configurations, and basic operation procedures.</td>
<td></td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual</td>
<td>IB-66793 (1DM176)</td>
</tr>
<tr>
<td>(Monitor Screen Creation Manual)</td>
<td></td>
</tr>
<tr>
<td>This manual describes how to create monitor screens, the monitor functions available for the GOT, how to set the monitor functions, precautions for creating monitor screens, and precautions for utilizing the monitor data of the conventional GOT.</td>
<td></td>
</tr>
<tr>
<td>Manual Name</td>
<td>Manual No.</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual</td>
<td>IB-66794</td>
</tr>
<tr>
<td>(Data Transmission/Debugging/Document Creation Manual)</td>
<td></td>
</tr>
<tr>
<td>This manual describes the following items:</td>
<td></td>
</tr>
<tr>
<td>(1) Procedures for downloading project data to the GOT and uploading it from the GOT</td>
<td></td>
</tr>
<tr>
<td>(2) Procedures for installing the operating system in the GOT</td>
<td></td>
</tr>
<tr>
<td>(3) Procedures for using the A8GOTP as a virtual programmable controller and for debugging the GOT</td>
<td></td>
</tr>
<tr>
<td>(4) Procedures for outputting created monitor data as a completed document</td>
<td></td>
</tr>
<tr>
<td>GOT800 Series Operating Manual (Expanded Functions Manual)</td>
<td>IB-66796</td>
</tr>
<tr>
<td>This manual describes the operation procedures for using the system monitor functions, monitor functions for special function units, and the dedicated monitor screens used with the ladder monitor functions.</td>
<td></td>
</tr>
<tr>
<td>Other's Programmable Controller · Bar-code Connection System Manual</td>
<td>IB-66797</td>
</tr>
<tr>
<td>This manual describes the system configuration, setting method and other information for connection of the GOT and another company's programmable controller.</td>
<td></td>
</tr>
<tr>
<td>A8GT-60PRF Printer Interface Unit User's Manual</td>
<td>IB-66730</td>
</tr>
<tr>
<td>This manual contains the specifications, settings and other information of the A8GT-60PRF Printer Interface Unit.</td>
<td></td>
</tr>
<tr>
<td>A8GT-70PRF Printer Interface Unit User's Manual</td>
<td>IB-66706</td>
</tr>
<tr>
<td>This manual contains the specifications, settings and other information of the A8GT-70PRF Printer Interface Unit.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 1

Overview
1. Overview

This manual describes the report function available for the SW3NIW-A8GOTP and SW3NIW-A8SYSYP.
The report function explained in this manual can be used by installing the SW3NIW-A8SYSYP in the GOT.

1.1 Features

The report function is designed to gather and print numerical data stored in the word devices or the buffer memory of a special function module every time a data collection trigger occurs, or to print comments associated with numerical data and bit device ON/OFF.
The report function is available in the following two types:

- Real-time, continuous report type
  
  With this function, data is gathered and printed per data collection trigger.
  
  When a collection trigger occurs, the current data and next data are printed continuously without the printer paper page being renewed.
- Logging, page-renewed report type (only available for the A870, unavailable for the A85□GOT)
  With this function, data is gathered and stored onto the memory card per data collection trigger, and the data stored on the memory card is printed when a print trigger occurs. Before printing, the printer paper page is renewed.

[Print example]

<table>
<thead>
<tr>
<th>Device - Amount</th>
<th>Device - Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processed: D100: 10pcs.</td>
<td>Processed: D100: 10pcs.</td>
</tr>
<tr>
<td>Processed: D100: 50pcs.</td>
<td>Processed: D100: 50pcs.</td>
</tr>
</tbody>
</table>

Report data file
- Data stored when the first data collection trigger occurred
- Data stored when the second data collection trigger occurred

<table>
<thead>
<tr>
<th>Device - Amount</th>
<th>Device - Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processed: D100: 30pcs.</td>
<td>Processed: D100: 30pcs.</td>
</tr>
<tr>
<td>Processed: D100: 70pcs.</td>
<td>Processed: D100: 70pcs.</td>
</tr>
</tbody>
</table>
1.2 Structure and Guide to the Use of This Manual

When this graphics software is purchased, it comes with six operating manuals. The manuals are categorized according to the purpose for which they are used. Please read the manual that corresponds to your particular objective in order to become familiar with the operations and functions of the software.

---

**SW3NIW-A8GOTP Operating Manual**

- Install the graphics software in the computer
- Start up the graphics software.
- Learn fundamental information and basic operations for the graphics

**Personal Computer**

- Graphic software

---

**SW3NIW-A8GOTP Operating**

- Create simple graphics, monitor them on the GOT, and learn the flow of assures of operations.

---

**SW3NIW-A8GOTP Operating**

- Actually create screens for monitoring using the GOT:
  - Drawing graphics
  - Sprite settings
  - Edit the data which has been created.

---

**SW3NIW-A8GOTP Operating**

- When implementing the report function, create report data.
- Create report data.
- Set report data.
- Edit the report data.
1. Overview

- Install the OS program and communication driver in the GOT.
- Download created graphics to the GOT.
- Debug graphics between the computer and GOT.
- Create data documents.

- Monitor circuits.
- Monitor the system.
- Monitor the special unit.

GOT800 Series User's Manual

- Install the optional units in the GOT.
- Connect the GOT and PC CPU.
- Find out how to attach the GOT and its external dimensions.
- Select a model.

SW3N/W2A/GOTP
Operating
Data transmission
Debugging
Document creation manual

Circuit monitor
System monitor
Special unit monitor

Expand functions Manual

GOT user's Manual
### 1.3 Abbreviations and Symbols Used in This Manual

The following abbreviations and symbols are used in this manual.

<table>
<thead>
<tr>
<th>Abbreviation/Terminology</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics software</td>
<td>This refers to the SW3NIW-A8GOTP.</td>
</tr>
<tr>
<td>Personal computer</td>
<td>This refers to a peripheral device in which the graphics software has been installed.</td>
</tr>
<tr>
<td>A870GOT</td>
<td>This indicates the A870GOT Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A850GOT</td>
<td>This indicates the A850GOT(-M3) Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A851GOT</td>
<td>This indicates the A851GOT(-M3) Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A852GOT</td>
<td>This indicates the A852GOT(-M3) Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A853GOT</td>
<td>This indicates the A853GOT(-M3) Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A85□GOT</td>
<td>This refers to the A850GOT/A851GOT/A852GOT/A853GOT Graphic Operation Terminal.</td>
</tr>
<tr>
<td>GOT</td>
<td>This indicates the abbreviation for the A870GOT/A85□GOT.</td>
</tr>
<tr>
<td>Conventional GOT</td>
<td>This indicates the A77GOT(S3/S5)/A64GOT.</td>
</tr>
<tr>
<td>Comment data</td>
<td>This is character string data created in order to display comments with the message display function.</td>
</tr>
<tr>
<td>Report project data</td>
<td>This indicates all report data created.</td>
</tr>
<tr>
<td>Report data</td>
<td>This indicates report-by-report data to which rules, characters and print allocation data have been set.</td>
</tr>
<tr>
<td>Print allocation data</td>
<td>This indicates numerical and comment data to be printed.</td>
</tr>
<tr>
<td>Canvas data</td>
<td>This indicates calculation and character data to be tabulated.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Command on a menu]</td>
<td>This indicates a command on a menu.</td>
</tr>
<tr>
<td>![Tool Bar 1]</td>
<td>This is the icon for the Tool Bar 1.</td>
</tr>
<tr>
<td>![Dialog box tab]</td>
<td>This indicates a dialog box tab.</td>
</tr>
<tr>
<td>![Displayed dialog box]</td>
<td>This indicates a displayed dialog box.</td>
</tr>
<tr>
<td>![Item in a dialog box]</td>
<td>This indicates an item in a dialog box for which a setting can be entered.</td>
</tr>
<tr>
<td>![Command button in a dialog box]</td>
<td>This indicates a command button in a dialog box.</td>
</tr>
<tr>
<td>![Point]</td>
<td>This indicates that the information is particularly important.</td>
</tr>
<tr>
<td>![Arrow Key] ![Enter]</td>
<td>These indicate keys on the computer keyboard.</td>
</tr>
</tbody>
</table>
Chapter 2

Where to Start
2. Where to Start

2.1 Information Required before Setting the Report Function

(1) Types of data that may be printed with the report function
   - Collected data
     Numerical data in the word devices and the special function
     unit buffer memory can be printed in decimal or hexadecimal.
     Comments associated with numerical data and bit ON/OFF
     can also be printed. (Refer to Chapter 6.)
   - Print time, page number
     Print time of day and page number can be printed for the data.
     (Refer to Section 4.6.)
   - Canvas data
     Rules and characters can be printed. (Refer to Chapter 5.)

(2) Printing of rules drawn with the report function
   On the screen, rules drawn with the report function are all displayed as continuous lines. When
   actually printed, vertical rules are printed as dotted lines.

(3) Storage of report project data
   Report project data must be stored in the same directory as the directory of the monitor screen
   data stored in the GOT.

   \directory name \a8gotp.got
   \a8gotp.got
   (File name and extension of monitor screen data)
   \a8gotp.got
   (File name and extension of monitor screen data)
   (Refer to Section 3.5.)

(4) Downloading of report data
   Report data cannot be downloaded from the report software. It should be downloaded from the
   graphics software. (Refer to Section 10.1.)

(5) Utilization of conventional GOT data
   The report data of the conventional GOT created with the SW□□□-AGOTP
   cannot be used as the report data of the SW3NIW-A8GOTP.

(6) Number of report data that may be registered to one report project
   For report data created with the report function, data of up to 8 reports may be registered to
   one report project.

(7) Number of print allocation data that may be set to one report
   For print allocation data set with the report function, up to 256 points may be set to one report.
(8) Setting items for report function
   The following items are set for the report function.
   Some items are valid for all report data in one report project and others are only valid for single report data.
   - PC type ........................................ Valid for all report data in one report project.
   - Common setting ................................
   - Parameter setting ..............................
   - Print allocation (numerical/comment) ...... Only valid for single report data.
   - Header/repeated line designation .........
   - Report title setting ............................

(9) Number of header/repeated lines and print allocation data that may be set
   Up to 10 header lines and up to 20 repeated lines (lines printed repeatedly per data collection trigger) may be set.
   In addition, repeated lines may include up to 256 pcs. of print allocation data per report data.
   (Refer to Chapter 7.)

(10) Required interface module
    For use of the report function, the following model of the interface unit is required:
    For use of the A870GOT ........................ A8GT-70PRF printer interface unit
    For use of the A85□□GOT ..................... A8GT-50PRF printer interface unit

(11) Usable printers
    Some models of the following printers which have been confirmed at Mitsubishi to operate properly may be used:
    - ESC/P24-J94-compatible printer (sold in Japan only)
    - Hewlett-Packard Co. printer (PCL command compatible, color incompatible)

    For the models confirmed to operate properly, refer to the "Operation Confirmation Peripheral Model List" (BCN-P5228) separately available.
    When that data is required, contact your sales representative.
    If the printer used is other than the model given in the "Operation Confirmation Peripheral Model List", it may not operate properly.
    *Note that the Hewlett-Packard Co. printers cannot be used when the Japanese mode is set on the graphics software

(12) Usable cables
    The following models of cables have been confirmed at Mitsubishi to operate properly:
    AC30PIO-20P
(13) Required memory capacities for report function
The report function has the following memory capacities for the setting items, rules and characters.
The memory capacities assume that all setting items have been set as default values for setting of numerical/comment printing.
When data expression, etc. have been set, the memory capacities are different from the following values (increase).

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Memory Capacity (Bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numerical print setting</td>
<td>44</td>
</tr>
<tr>
<td>Comment print setting</td>
<td>Bit, word</td>
</tr>
<tr>
<td>Rule</td>
<td>Straight line, quadrangle</td>
</tr>
<tr>
<td>Character</td>
<td></td>
</tr>
</tbody>
</table>

Confirm the memory capacity for the whole report project data in the following procedure.
1. Select [Download] ➤ [Monitor Data] on the Communication menu of the graphics software.
2. Select "Select date" to be downloaded in the [Monitor Data Download] dialog box.
3. Click [Report] to select all report data.
4. By clicking [Setting], the memory capacity of the whole report project data is displayed in "Transfer size (byte)".

(14) When print timings of print-out function occur at the same time
(a) When print timings of more than one report occur at the same time
   After completion of the data currently printed, the printing of the report data of which collection/print trigger occurred is started.
   Note that if the collection/print trigger of that report occurs during data printing, that collection/print trigger is made invalid.

(b) The following operation is performed when the collection/print trigger of another report or hard copy (including the print-out of ladder monitor) occurs during data collection or printing of the current report.

<table>
<thead>
<tr>
<th>Data of which collection trigger occurred during printing</th>
<th>Print data</th>
<th>Report 1)</th>
<th>Report 2)</th>
<th>Hard copy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report 1)</td>
<td>x</td>
<td>O</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>Report 2)</td>
<td>O</td>
<td>x</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>Hard copy</td>
<td>O</td>
<td></td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

O: Printed  x: Not printed
(15) Data collection trigger of logging report data

Operation changes with the condition in which the data collection trigger of logging report data occurs, as indicated below.

<table>
<thead>
<tr>
<th>Phenomenon</th>
<th>During printing</th>
<th>During data collection</th>
<th>During collection of another logging report data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Occurrence of data collection trigger</td>
<td>O</td>
<td>x</td>
<td>O</td>
</tr>
</tbody>
</table>

O: Collected  x: Not collected

(16) Page renewal operation for combined use of real-time report and hard copy functions

When the real-time report and hard copy functions are used together, page renewal control is exercised as described below.

(a) When printing one report after the other report
   Control depends on the before-printing page renewal YES/NO setting made with the report function. (See Example 1.)

(b) When printing hard copy after a report
   Page renewal control is always exercised before hard copy printing. (See Example 2.)

(c) When printing hard copy after hard copy
   Control depends on the after-printing page renewal YES/NO setting made with the hard copy function. (See Example 3.)

(d) When printing a report after hard copy
   Control depends on the after-printing page renewal YES/NO setting made with the hard copy function. (See Example 4.)

---

*Example 1*

(a) Before-printing page renewal set to YES
   - Report 1
   - Report 2

(b) Before-printing page renewal set to NO
   - Report 1
   - Report 2

---

*Example 2*

(a) Before-printing page renewal set to YES
   - Report
   - Hard copy

---

*Example 3*

(a) Before-printing page renewal set to YES
   - Hard copy

(b) Before-printing page renewal set to NO
   - Hard copy

---

*Example 4*

(a) Setting of page renewal after hard copy printing
   - YES
   - NO

(b) Setting of page renewal after before report printing
   - YES
   - NO

---

*1: Page may be renewed according to the number of printed lines of the report data.
*2: After-printing page renewal: This example shows a setting that page renewal is made after printing of one screen.
(17) Page renewal operation for combined use of logging report and hard copy functions

When the logging report and hard copy functions are used together, page renewal control is exercised as described below.

(a) When printing one report after the other report
Page renewal control is always exercised between report printings. (See Example 1.)

(b) When printing hard copy after a report
Page renewal control is always exercised before hard copy printing. (See Example 2.)

(c) When printing hard copy after hard copy
Control depends on the after-printing page renewal YES/NO setting made with the hard copy function. (See Example 3.)

(d) When printing a report after hard copy
Page renewal control is always exercised before report printing. (See Example 4.)

*1: After-printing page renewal: This example shows a setting that page renewal is made after printing of one screen.
2.2 Report Creating Procedure Outline

An outline of report creation procedure will be described. The following flowchart indicates an outline procedure from startup of the report software to data downloading to the GOT main unit:

- Install the SW3NIW-GOT800PSET in the personal computer and start up the graphics software and report software. Refer to Section 2.3 of the SW3NIW-A8GOT Operating manual (Startup Manual).

  - Set the PC type for the report project data to be created. Refer to Section 4.1.

  - Set the operating/display environment of the report software. Refer to Sections 4.3, 4.4.

  - Choose [Common] on the Setting menu and set the format, margins etc. Refer to Section 4.2.

    - Set the title of the report data. Refer to Section 4.5.

    - Set parameters. Refer to Section 4.0.

    - Create a report canvas. Refer to Section 5.

      - Make print allocation. Refer to Section 6.

      - Specify the header/repeated lines. Refer to Section 7.1.

      - Store the report data created. Refer to Section 3.5.

    YES

    - Next report data created?

    NO

    - Startup the graphics software.

    - Download the report project data to the GOT main unit. Refer to Section 10.1.


2.3 Startup of the Report Software

Turn on the power supply to the computer and start up Windows 3.1 or Windows 95.

Move the cursor to the SW3 Report icon and click on it.

Move the cursor to Got800 in the start menu program and click it, then, move the cursor to SW3 Report and click it.

The report software start up (for Windows 95)
Chapter 3

Creating Data
3. Creating Data

3.1 Creating New Report Project Data

- When to use this function?
  - When newly creating report project data.
  - When closing the report project data currently being created and newly creating another report project data.

When the report software starts up, it opens a new report screen for the first report, on which you can create the first report.

The following operation assumes that the report project data is now open and another report project data is to be newly created:

1. Choose New / Close on the Project menu.

2. As the message dialog box appears, follow the messages.
   - If you have not yet stored the open report project data onto hard disk or floppy disk, the operation of storing the report project data onto hard disk or floppy disk begins. After completion of storage, new data may be created.
   - If you have not assigned a file name to the open report project data, it should be named before it is stored, i.e. Save As operation is performed.
   - If you have assigned a file name to the open report project data, the old data is overwritten by new data, i.e. Save operation is performed.

3. The open report project data closes and the first report may be created newly.
3.2 Creating the Next Report Project Data/Opening the Report Project Data to Be Edited

When to use this function?
- When creating next report data newly.
- When opening a report window to be edited on the application window to edit report data.


<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Report No.&quot;</td>
<td>When newly creating/editing the next report data, set the report No. in the spin box.</td>
</tr>
<tr>
<td>&quot;Report title list&quot;</td>
<td>When opening the report data to be edited, create the report No. to be edited in the text box.</td>
</tr>
<tr>
<td>Set title</td>
<td>When setting a title, click [Set title].</td>
</tr>
</tbody>
</table>

3. As the report window of the selected report No. opens on the application window, create/edit the report data.
3.3 Overlapping or Tiling the Open Report Windows

When to use this function?
- When rearranging two or more report windows opening on the application window.

1. Select **Cascade** / **Tile** on the Report menu.

2. The report windows are displayed one over another or side by side.

Overlapping

The report windows are displayed one over another in tiers from left to right.

Tiling

The report windows are displayed side by side without overlapping one another.
3.4 Closing the Report Window on the Application Window

When to use this function?

- When it is desired to close the report window on the application window.
  (When two or more report windows are open on the application window)

1. Activate the report window to be closed and choose [Clear] or [Clear and Load] on the Report menu.

2. When you have chosen [Clear], the specified report window closes and the foremost report window becomes active.
   When you have chosen [Clear and Load], the [Load Report] dialog box appears.
   The data of the closed report window is stored in the temporary area.
- When it is desired to store the created/edited screen data of the report window without closing the report window, select [Save] on the Report menu.
3.5 Storing the Report Project Data on Hard Disk or Floppy Disk

When to use this function?

- When storing the created/edited report project data on hard disk or floppy disk.

When storing the report project data, use the same directory name as that of the monitor screen data stored in the GOT.

\directory name \a8gotp.got
\(\uparrow\)
(File name and extension of monitor screen data)
Must be stored in the same directory.
\a8gotp.got
(File name and extension of monitor screen data)

When storing the report project data, any of the following cases is possible.
Select the proper command on the Project menu to store the report project data on hard disk or floppy disk.

<table>
<thead>
<tr>
<th>Case</th>
<th>Command Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>When the created report project data is stored on hard disk or floppy disk for the first time.</td>
<td>[Save As] on the Project menu.</td>
</tr>
<tr>
<td>When the report project data already stored on hard disk or floppy disk is opened and edited and the edited report project data is stored with another file name.</td>
<td></td>
</tr>
<tr>
<td>When the report project data already stored on hard disk or floppy disk is opened and backed up with another file name.</td>
<td>[Save As] on the Project menu.</td>
</tr>
<tr>
<td>When the report project data already stored on hard disk or floppy disk is opened, edited, and stored with the current file name whose data will be overwritten.</td>
<td></td>
</tr>
</tbody>
</table>

Store report project data periodically to prepare for a power failure or system fault and to minimize damage.

(1) Save As

1. Choose [Save as] on the Project menu.
2. The [Save As] dialog box appears.

In the "Drives" list box, choose the drive to which the data will be stored.

(To the next page)
(From the preceding page)

In the "Directories" list box, specify the directory name of the monitor screen data for storage of the report project data.

The "Drives" list box, choose the drive to which the data will be stored.

When creating a new directory name, click MkDir.

The [Make Directory] dialog box appears.

```
Make Directory

Name:          OK
              Cancel
```

Enter the file name into the "Name" text box.
(Example) \REPORT

Click OK in the [Make Directory] dialog box.

The [Save As] dialog box appears.

Click OK in the [Save As] dialog box.

3. The report project data is stored in the specified directory and report project data editing may be made again.
The file name and extension are fixed to report.got.
Create the directory and file names in accordance with the creation rule of the MS-DOS.

(2) Save
1. Choose [Save] on the Project menu.

2. As the message dialog box appears, follow the messages.

3. The data of the current file name is overwritten by the report project data and report project data editing may be made again.
3.6 Opening the Report Project Data Stored on Hard Disk or Floppy Disk

When to use this function?

- When opening the report project data on the report software to edit the report project data stored on hard disk or floppy disk.


2. As the message dialog box appears, perform operation according to the message.
   - If you have not yet stored the current open report project data onto hard disk or floppy disk, the operation of storing the report project data onto hard disk or floppy disk begins.
   - After completion of storage, the [Open Project] dialog box appears.
   - If you have not assigned a file name to the open report project data, it is named before stored.
   - If you have assigned a file name to the open report project data, save operation is performed.

3. The [Open] dialog box appears.

   ![Open Dialog Box]

   Select the drive for the report project in the "Drives" list box.

   Specify the directory name for the report project to be opened in the "Directories" list box.

   Click [OK].

4. The specified report project data opens and the first report may be edited.
3.7 Copying the Report Project Data from Another Project

When to use this function?

- When copying the data created in another report project to the report project currently being edited.

If report data exists in the report project of copy destination, note that that data will be erased before copying.

1. Select **Import File** → **Project** on the Project menu.

2. The [Import From Project] dialog box appears.

   ![Import From Project dialog box]

   Click **Browse** in the "source ".

3. The [Browse] dialog box appears.

   ![Browse dialog box]

   Specify the directory of the report project to be used as the copy source. Click **OK**.
4. The [Import From Project] dialog box appears.

Click the copy source report title display position in the [Copy setting] to select the report data to be copied.

More than one report number may be selected for copying.

To reset the report number selected, click the report title display position again.

Set the copy destination report number in [Destination report No.].

• Set the copy destination head report number between 1 and 8.

5. After completion of setting, click [Import].

Copying starts.

On completion of copying from another project, click [Cancel].
Chapter 4

What to Do First
4. What to Do First

4.1 PC Type Setting

What to set?

- Set the type of the PC for the report project data you are going to create.

1. Select **PC Type** on the Setting menu.

2. The [PC Type] dialog box appears.

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;PC Type&quot;</td>
<td>In the list box, select the type of the CPU whose data will be gathered with the report function.</td>
</tr>
</tbody>
</table>

- What will happen if you change the PC type during data creation?
  
  Devices compatible differ between the MELSEC-A, QnACPU, MELSEC-FXCPU, OMRON's PLC, Yaskawa Electric's PLC, Allen-Bradley's PLC and microprocessor. Therefore, note that the devices set for printing will be changed if the PC type is changed during data creation or after the report project data stored has been opened. Check each print allocation data to see if devices have been changed. If there is no device which corresponds to the new PC type, the devices set earlier will be deleted, so the devices to be printed need setting again. "??" will be displayed in the "Display Device" field.
4.2 Common Setting

What to set?

- Set the format of the report project data you are going to create and a trigger for aborting printing.

1. **[Common]** on the Setting menu.


```
<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Form&quot;</td>
<td>Lines — In the spin box, set the number of lines (1 to 127) to be printed on a single page. Column — In the spin box, set the number of columns (1 to 255) to be printed on a single line.</td>
</tr>
</tbody>
</table>

- The margins may be slightly greater than the settings depending on the printer used.

```

```
| "Space" | Top — In the spin box, specify how many lines of margin will be left at the top of the report project data. The setting range is 0 to 30. Left — In the spin box, specify how many columns of margin will be left on the left of the report project data. The setting range is 0 to 254. |

```

```
<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Change Page&quot;</td>
<td>Yes --- Printer paper page is renewed before printing. No --- Printer paper page is not renewed before printing.</td>
</tr>
<tr>
<td>&quot;Trigger watch cycle&quot;<strong>1</strong></td>
<td>In the spin box, set the interval at which the states of the bit devices set for the data collection trigger are viewed in the PLC. The interval may be set in 1 second increments from a minimum of 1 second. The bit devices set for data collection trigger should be on/off for longer than the time set for the Trigger watch cycle.</td>
</tr>
<tr>
<td>&quot;Abort trigger&quot;</td>
<td>Click [Dev] and set the device for aborting printing.</td>
</tr>
<tr>
<td>&quot;Initialize the number of form feed lines after aborting&quot;</td>
<td>Use the check box to select whether to initialize the number of form feed lines or not after aborting printing.</td>
</tr>
</tbody>
</table>

**1**: When the number of device points increases, collection time will be longer and the collection trigger may be skipped.

**2**: When the logging report function (pre-printing form feed: yes) is used or "pre-printing form feed" is set to "YES", the choice in the check box will be made invalid.

The following is a valid example of using the "Initialize the number of form feed lines after aborting" check box:

<table>
<thead>
<tr>
<th>Step</th>
<th>When Check Box Is Checked</th>
<th>When Check Box Is Not Checked</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>Perform report printing under the following operating conditions:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item</td>
<td>Report Form</td>
</tr>
<tr>
<td></td>
<td>Setting</td>
<td>Real-time continuous</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Several pieces of data are printed)</td>
</tr>
<tr>
<td>2)</td>
<td>While several pieces of data are printed, set the abort trigger to abort printing.</td>
<td></td>
</tr>
<tr>
<td>3)</td>
<td>After printing has been aborted, feed the print paper manually to the beginning of the next page before starting the next printing.</td>
<td></td>
</tr>
<tr>
<td>4)</td>
<td>Resume printing.</td>
<td></td>
</tr>
<tr>
<td>5)</td>
<td>Printing result</td>
<td></td>
</tr>
<tr>
<td></td>
<td>As the number of form feed lines was initialized, printing can be done properly without any problem.</td>
<td></td>
</tr>
</tbody>
</table>
### 4.3 Setting the Operation Environment for the Report Software

**What to set?**

- "Work area" which is used to specify the temporary area where report project data will be stored temporarily.
- "Project of edit" which is used to set whether the specified report project data will be opened the next time the report software is booted or the system will be ready for new data to be created the next time the software is booted.
- "Overwrite message" which is used to specify whether the message dialog box will be displayed or not when [Save] was selected on the File menu/Report menu to save the report file/report project.

1. Select [Option] ➤ [File] on the Project menu.

2. The [File Option] dialog box appears.

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Work area&quot;</td>
<td>Click [Browse]. As the [Browse] dialog box appears, specify the drive and directory name of the temporary area.</td>
</tr>
<tr>
<td>&quot;Project of edit&quot;</td>
<td>Using the radio buttons, select the status for the next time the report software is booted. Select every time - The system will be ready for new data to be created the next time the software is booted. Fixed - The specified report project data will be opened the next time the software is booted. When Fixed is selected, click [Browse]. As the [Browse] dialog box appears, specify the drive, directory name and file name of the report project.</td>
</tr>
<tr>
<td>&quot;Overwrite message&quot;</td>
<td>When the save confirmation message dialog box is not to be displayed, choose the check box to erase the check mark.</td>
</tr>
</tbody>
</table>

[Diagram showing the save confirmation message dialog box]
4.4 Setting the Display Environment for the Report Software

What to set?

- "Item" which is used to specify whether the tool bar and status bar are displayed or not.
- "Grid" which is used to specify whether the grids are displayed on the report window or not.

1. Select Option ➤ View on the Project menu.

2. The "View Option" dialog box appears.

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Item&quot;</td>
<td>Choose the check box on the left of the tool bar or status bar to be erased to erase the check mark. When the erasure of the tool bar is specified, the tool bar at the top of the screen disappears and the screen window display range increases accordingly. When the erasure of the status bar is specified, the status bar at the bottom of the screen disappears and the screen window display range increases accordingly.</td>
</tr>
<tr>
<td>&quot;Grid&quot;</td>
<td>Using the radio buttons, select whether grids will be displayed on the report window or not. Front/Back ... Grids are displayed. (Grid spacing is fixed at 16 dots.) None .......... Grids are not displayed.</td>
</tr>
</tbody>
</table>
4.5 Setting the Report Title

Why is this done?

- To title the report per created report screen for ease of understanding.

1. Choose [Title] on the Setting menu.

2. The [Report Title] dialog box appears.
   In the "Report list" text box, click the display position of the report No. of which title will be set.
   Click [Edit].

3. Enter the title in the "Title" text box.
   (Up to 64 may be entered.)
   In the "Detailed explanation" text box, enter the explanation for the report as required. (Up to 1024 may be entered.)
   Click [OK].

   When correcting the title already set, click the display position of the report No. to be corrected, and perform the same operation as in setting.
   On completion of title setting, click [OK].
4.6 Setting the Parameters

What to set?

- Select the report type between the real-time continuous and logging page-renewed types.
- Specify whether the page number and time of day are printed on the report paper or not.
- Set the collection trigger for data collection.

4.6.1 Selecting Real-Time Continuous Type


2. The [Parameter] dialog box appears.

In the "Report No." text box, click the display position of the report No. of which parameters will be set.

Click [Edit].


Format

Report style

Page No.: [Print at right top]

Time: [Not print]
(1) Setting Format

"Report Style"  Choose the "Real/cont" radio button.
Real/cont Data is gathered and printed per data collection trigger.
"Page No" Specify whether the page number and time of day will be printed on the report paper or not, and "Time" when printed, in what position of the report paper they will be printed.

(Example) Printed "at left top"  Printed "at center"  Printed "at right top"

<table>
<thead>
<tr>
<th>Production List</th>
<th>Production List</th>
<th>Production List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Amount</td>
<td>Device Amount</td>
<td>Device Amount</td>
</tr>
<tr>
<td>Proceed D100</td>
<td>10pcs. D102</td>
<td>30pcs.</td>
</tr>
<tr>
<td>Products D101</td>
<td>20pcs. D102</td>
<td>40pcs.</td>
</tr>
<tr>
<td>Proceed D100</td>
<td>50pcs. D102</td>
<td>70pcs.</td>
</tr>
<tr>
<td>Products D101</td>
<td>60pcs. D102</td>
<td>80pcs.</td>
</tr>
</tbody>
</table>

The time of day is displayed in order of the date and time of day from left to right. (Fixed)
The number of display digits is fixed to 17.

\[ 96/11/30 \quad 17:38:04 \]

The year is displayed as its two least significant digits. The time of day is displayed in a 24-hour system.

(2) Setting Tigger

"Collect trigger" Click [Dev] and set the device of which data will be gathered in the [Device] dialog box.
Rise Data is gathered when the device switches from off to on.
Fall Data is gathered when the device switches from on to off.
- Device setting for collection trigger cannot be repeated in each report data.
- The bit devices set for data collection trigger should be on/off for longer than the time set for the trigger monitor interval.
4.6.2 Selecting the Logging Page-Renewed Type


2. The [Parameter] dialog box appears.

In the "Report No." text box, click the display position of the report No. of which parameters will be set.

Click [Edit].


(1) Setting [Format]

"Report Style" Choose the "Log/page" radio button.
Log/page · · · · · · Data is gathered and printed per data collection trigger.

"Page No" Specify whether the page number and time of day will be printed on the report paper or not, and when printed, in what position of the report paper they will be printed.
The time of day is displayed in order of the date and time of day from left to right. (Fixed)
The number of display digits is fixed to 17.

96/11/30 17:38:04
Space

17 digits

The year is displayed as its two least significant digits. The time of day is displayed in a 24-hour system.

(2) Setting Tigger

"Collect trigger" Click Dev and set the device of which data will be gathered in the [Device] dialog box.
Rise · · · · · · · Data is gathered when the device switches from off to on.
Fall · · · · · · · Data is gathered when the device switches from on to off.
Sampling · · · · Set the data collection interval in the range 3 to 3600 seconds (3 seconds to 60 minutes).
(Only used when "logging page-renewed" is selected)
• Device setting for collection trigger cannot be repeated in each report data.
• The bit devices set for data collection trigger should be on/off for longer than the time set for the trigger monitor interval.

"Print trigger" Click Dev and set the device of which data will be gathered in the [Device] dialog box.
Rise · · · · · · · Data is printed when the device switches from off to on.
Fall · · · · · · · Data is printed when the device switches from on to off.
3. Setting Log

(When "real-time continuous" is selected, "Logging" is grayed out and page selection cannot be made.)

- **Repeat num**
  Set how many times the line to be repeated will be repeated at print trigger occurrence in the range 0 to 499.

- **Sampling num**
  Set how many times data will be stored in the file area (number of records) in the range 1 to 500.

  
  When setting this, consider the number of repeat times set above.

  When the repeat count set is less than the collection count by 1, the gathered data can be printed effectively.

  A setting example is indicated below.

  *(Example)* When the repeat count is set to 2 and the collection count to 3

- **Over processing**
  Specify whether data will be saved in the file area or data storage will be aborted when the next data collection trigger takes place after data has been stored in the file area by the number of collection times as set above.

  **Over write**
  Old data is overwritten by new data to continue data storage in due order, beginning with the data stored at occurrence of the first data collection trigger (first record).

  **Break**
  Data is not stored if the next data collection trigger occurs.

  To store data once more, delete all data stored.

  Data may be deleted under the condition set in "Data deletion trigger".
"Data deletion trigger"  Set the timing of deleting the data stored.
Rise/Fall  When data is being stored in the report file area or printed at the rise/fall timing of the user-specified device, data is deleted after completion of that processing. To set the user-specified device, click [Dev] and set it in the [Device] dialog box.
Turn on  Data is deleted when the GOT starts up.
Print  Data is deleted after completion of printing started by the print trigger.

"Logging"
Specify the order of printing the data stored in the file area.
Oldest  Data stored in the file area is printed in the order of least to most recent data.
Latest  Data stored in the file area is printed in the order of most to least recent data.

"File name"  Specify the file name for data storage in the form of "name (within 8 characters).extension (within 3 characters)" using upper-case letters and numerals (0 to 9).
Chapter 5

Creating Canvas Data
5. Creating Canvas Data

5.1 Drawing Rules

Rules may either be drawn by selecting the tool bar icon or Setting menu command.

--- Tool Bar ---

Selected icon

--- Menu Bar ---

Selected command

on Setting menu [Line]

<How to draw a straight line>  <How to draw a quadrangle>

1. Move the cursor to the starting point of a straight line or rectangle.

   ![Diagram of starting point for a line]

   ![Diagram of starting point for a rectangle]

2. Press the left button of the mouse at the starting point and drag the mouse to move the cursor to the end point.

   To draw a square, hold down [SHIFT] and drag the mouse.

   ![Diagram of drawing a square with [SHIFT]]

3. Release the left button of the mouse at the end point.

   ![Diagram of releasing the mouse at the end point]

- Rules that may be drawn with the report function
  Straight lines (horizontal and vertical lines), squares and rectangles may only be drawn with the report function.
  Drawn rules are displayed as continuous lines on the screen but vertical rules are printed actually as *******.
  Also, rules and characters cannot be overlapped.
5.2 Entering Text

A text may either be entered by selecting the tool bar icon or Setting menu command.

<table>
<thead>
<tr>
<th>Tool Bar</th>
<th>Menu Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected icon</td>
<td>Selected command</td>
</tr>
<tr>
<td>![A icon]</td>
<td>on Setting menu</td>
</tr>
<tr>
<td>![Text icon]</td>
<td>Text</td>
</tr>
</tbody>
</table>

1. The [Text] dialog box appears.

![Text dialog box]

2. Enter a the text input text box.
   The text scale factor is fixed to full size and the vertical and horizontal scale factors cannot be changed.

3. Click [OK].
4. A text frame indicating the size of the displayed text is shown at top left of the screen window.

![Text frame]

5. Move the cursor to the position where the text is to be displayed.

![Cursor position]

6. Click that position.

![Click position]

- Text attributes of the report function
  In the report function, text attributes cannot be changed and a text cannot be displayed vertically. Rules and texts cannot be overlapped, either.
Chapter 6

Setting the Print Allocation Data
6. Setting the Print Allocation Data

What to set?

- Set the numerical data/comment data printing position, printed device, printing format, etc. for report paper printing.

6.1 Print Allocation Setting for Numerical Data

The [Numerical Print] dialog box appears.

1) Setting (Basic)

"Print device" Click [Dev] and set the device to be printed.

"Print Style" Set the format in which device values and data expression results are printed. For the printing format setting method, refer to Section 11.1 in the SW3NiW-A8GOTP Operating Manual (Monitor Screen Creation Manual).
2) Setting **Expression**

Set the expression for calculating the value of the device set.
For the data expression setting method, refer to Section 10.2.3 in the SW3NIW-A8GOTP Operating Manual (Monitor Screen Creation Manual).

3) Setting the display position

1. When each tab setting is complete, click **OK** for any tab.
2. A dotted line frame appears at top left of the screen window.

3. Move the cursor and click the position where the data is to be displayed.
6.2 Print Allocation Setting for Comment Data

Use the graphics software to create comment data to be printed. For creation of comment data, refer to Section 12.1 in the SW3NIW-A8GTP Operating Manual (Monitor Screen Creation Manual).

Comment data to be printed cannot be created with the report software.

![Toolbar and menu bar with comment icon and command](image)

The [Comment Print] dialog box appears.

1) Setting **Basic**

"Print digits"  
In the spin box, set the number of digits in which a comment will be printed. With a half-width character treated as a single digit, up to 255 digits may be set.

"Printed device"  
Click **Dev** and set the device to be printed. When a word device has been set, the comment number corresponding to the value of the word device set is printed.

"Comment No.(bit)"  
Specify the comment to be printed at ON/OFF of a bit when a bit device or the bit of a word device has been specified as the printed device. The comment number may be set between 0 and 32767. (When you specify 0, the comment is not printed.)
2) Setting Expression

Set the expression for calculating the value of the device set. For the data expression setting method, refer to Section 10.2.3 in the SW3NIW-A8GOTP Operating Manual (Monitor Screen Creation Manual).

3) Setting the display position

1. When each tab setting is complete, click **OK** for any tab.
2. A dotted line frame appears at top left of the report window.

3. Move the cursor and click the position where the data is to be displayed.
Chapter 7

Setting the Header and Repeated Lines
7. Setting the Header and Repeated Lines

7.1 Specifying the Header and Repeated Lines

What to specify?

- Specify the range of the header (e.g. title) for a report data.
- Specify a repeatedly printed range per data collection trigger.

Repeated lines must be set for each report data.
The header and repeated lines may either be set by selecting the Setting menu command or tool bar icon.

<When selecting the Setting menu command>
The [Header/Repeat range] dialog box appears.

```
<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Header range&quot;</td>
<td>Specify whether the header will be set or not. When setting the header, specify the starting and end lines of the header in the spin box. The setting ranges of the starting and end lines are both 1 to 20. (Example)</td>
</tr>
<tr>
<td>&quot;Repeat range&quot;</td>
<td>Specify the starting and end lines of the repeated lines in the spin box. The setting ranges of the starting and end lines are both 1 to 20. (Example)</td>
</tr>
</tbody>
</table>
```

Production List

<table>
<thead>
<tr>
<th>Device</th>
<th>Amount</th>
<th>Device</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>D100</td>
<td>10 pcs.</td>
<td>D102</td>
<td>30 pcs.</td>
</tr>
<tr>
<td>D101</td>
<td>20 pcs.</td>
<td>D103</td>
<td>40 pcs.</td>
</tr>
</tbody>
</table>

Processed products
- Set the header within 10 lines and the repeated lines within 20 lines.
- Avoid overlapping the header and repeated lines.
- Always make print allocation for repeated lines within the range 1 to 256 pcs. The header cannot include print allocation.

2. After setting is over, click **OK**.

The specified lines are set as the header/repeated lines.

- Display of the specified header/repeated lines
  The lines specified as the header are shown in a dark sky blue frame. The lines specified as the repeated lines are shown in a yellow frame.
<When using the tool bar icon>

1. Choose **Line Select** on the **Edit** menu on the tool bar.

2. Drag the mouse to select the range of specifying the header/repeated lines.

- Set the header within 10 lines and the repeated lines within 20 lines.
- Avoid overlapping the header and repeated lines.
- Always make print allocation for repeated lines within the range 1 to 256 pcs. The header cannot include print allocation.

3. Click **H** to specify the specified range as the header, or **R** to specify it as the repeated lines.

4. The specified lines are set as the header/repeated lines.
7.2 Resetting or Changing the Header

1. Choose [Header/Repeat] on the Setting menu.
   The [Header/Repeat] dialog box appears.

2. To reset the header, change the Header choice in the list box to "Not set".
   To change the header position, specify the starting and end lines in the spin box.

3. When setting is over, click [OK].

7.3 Changing the Repeated Lines

1. Choose [Header/Repeat] on the Setting menu.
   The [Header/Repeat] dialog box appears.

2. In the spin box, specify the starting and end lines of the repeated lines to be changed.

3. When setting is over, click [OK].
Chapter 8

Editing the Report Data and Print Allocation Data Created
8. Editing the Report Data and Print Allocation Data Created

8.1 Correcting the Rules or Characters

(1) Changing the size of the rules drawn
   <Using the mouse>
   1. Choose [Date Select] on the [ ] /Edit menu on the tool bar.

   2. Choose the rule of which size will be changed.

   For straight line
   For quadruple

   3. Move the cursor to the position of the rule handle.

   4. As the cursor displayed changes to a size changing cursor, press the left button of the mouse and drag the mouse to move the cursor to the position of a new size.

   5. Release the left button of the mouse in the position of the new size.
<Using the keyboard>

1. Choose **Data Select** on the **/Edit** menu on the tool bar.

2. Choose the rule of which size will be changed.

3. Using the **Arrow key** , move the cursor to the corner of the rule handle.

4. As the cursor displayed changes to a size changing cursor, press **Enter** and move the cursor to the position of a new size using the **Arrow key** .

5. Press **Enter** in the position of the new size.

(2) Changing the characters

1. Choose **Data Select** on the **/Edit** menu on the tool bar.

2. Choose the characters to be changed.

3. Move the cursor to the position of the characters to be changed and double-click, or choose **Edit Text** on the Edit menu.

4. As the [Text] dialog box appears, change the characters.
   (Refer to Section 5.2 "Entering Text").
8.2 Editing the Rules or Characters

(1) Moving the rules or characters

<Using the mouse>

1. Choose [Date Select] on the /Edit menu on the tool bar.

2. Choose the rules to be moved.

3. Move the cursor to within the rules.

4. As the cursor displayed changes to a moving cursor, press the left button of the mouse and drag the mouse to move the cursor to a new position.

5. Release the left button of the mouse in the new position.

<Using the keyboard>

1. Choose [Date Select] on the /Edit menu on the tool bar.

2. Choose the rules to be moved.

3. Using the [Arrow key], move the cursor to within the rules.

4. As the cursor displayed changes to a moving cursor, press [Enter] and move the cursor to a new position using the [Arrow key].

5. Press [Enter] in the new position.
(2) Copying the rules or characters
   1. Choose **Data Select** on the **Edit** menu on the tool bar.

   2. Choose the rules or characters to be copied.

   ![Production monitor amount]

   ![Selection frame]

   3. Choose **Copy** on the **Edit** menu on the tool bar.

   4. The rules or characters selected are stored on the clipboard.

   ![Clipboard]

   ![Clipboard]

(3) Pasting the rules or characters stored on the clipboard
   1. Choose **Paste** on the **Edit** menu on the tool bar.

   ![Cursor moved]

   2. As the cursor displayed changes to a moving cursor and the image of the rules or characters stored on the clipboard is being displayed, move the cursor to the pasting position.

   ![Cursor moved]

   3. Click in the pasting position.
(4) Deleting the rules or characters

2. Choose the rules or characters to be deleted.


(5) Cutting and storing the rules or characters on the clipboard

2. Choose the rules or characters to be cut.


As the cut rules or characters are stored on the clipboard, they can be pasted on the clipboard again.
(Refer to "(3) Pasting the rules or characters stored on the clipboard" in Section 8.2.)
8.3 Editing the Print Allocation Data

(1) Moving the print allocation data

<Using the mouse>


2. Choose the print allocation data to be moved.

3. Move the cursor to within the print allocation data.

4. As the cursor displayed changes to a moving cursor, press the left button of the mouse and drag the mouse to move the cursor to a new position.

5. Release the left button of the mouse in the new position.

<Using the keyboard>


2. Choose the print allocation data to be moved.

3. Using the [Arrow key] move the cursor to within the print allocation data.

4. As the cursor displayed changes to a moving cursor, press [Enter] and move the cursor to a new position using the [Arrow key].

5. Press [Enter] in the new position.
(2) Copying the print allocation data
1. Choose [Date Select] on the [/Edit menu on the tool bar.

2. Choose the print allocation data to be copied.

3. Choose [Copy] on the [/Edit menu on the tool bar.

4. The print allocation data selected is stored on the clipboard.

(3) Pasting the print allocation data stored on the clipboard

2. As the cursor displayed changes to a moving cursor and the image of the print allocation data stored on the clipboard is being displayed, move the cursor to the pasting position.

3. Click in the pasting position.
(4) Deleting the print allocation data
   1. Choose [Date Select] on the [X]/Edit menu on the tool bar.

   2. Choose the print allocation data to be deleted.


(5) Cutting and storing the print allocation data on the clipboard
   1. Choose [Date Select] on the [X]/Edit menu on the tool bar.

   2. Choose the print allocation data to be cut.

   3. Choose [Cut] on the [X]/Edit menu on the tool bar.

As the cut print allocation data is stored on the clipboard, it may be pasted on the clipboard again.
(Refer to "(3) Pasting the print allocation data stored on the clipboard" in Section 8.3.)
Chapter 9

Editing the Report Project Data
Created
9. Editing the Report Project Data Created

9.1 Copying the Created Report Data to Another Report Number

When to use this function?

- When copying the created report data to another report number


<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Action&quot;</td>
<td>Choose the Utilize radio button.</td>
</tr>
<tr>
<td>&quot;Source/Delete No.&quot;</td>
<td>Click the title display position of the report number to be copied. Two or more report numbers may be chosen for copying. To reset the report number chosen, click its title position again.</td>
</tr>
<tr>
<td>&quot;Utilize number&quot;</td>
<td>Set the number of utilization times in the spin box. By setting the number of utilization times, the corresponding report numbers starting from the destination report number become the copy destination.</td>
</tr>
<tr>
<td>&quot;Destination No.&quot;</td>
<td>Set the copy destination report number in the spin box. After completion of setting the copy source and destination report numbers, click [Execute]. Copying starts. The title data of the report number is also copied.</td>
</tr>
<tr>
<td>Close</td>
<td>Choose this on completion of copying.</td>
</tr>
</tbody>
</table>
9.2 Deleting the Created Report Data on a Report Number Basis

When to use this function?

• When batch-deleting the created report data on a report number basis


<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Action&quot;</td>
<td>Choose the Delete radio button.</td>
</tr>
<tr>
<td>&quot;Source/Delete No.&quot;</td>
<td>Click the title display position of the report number to be deleted. Two or more report numbers may be chosen for deletion. To reset the report number chosen, click its title position again. Click [Execute] to start deletion. The title data of the report number is also deleted.</td>
</tr>
<tr>
<td>Close</td>
<td>Choose this on completion of copying.</td>
</tr>
</tbody>
</table>
9.3 Changing the Report Number of the Report Data Created

- When to use this function?
  - When changing the report number of the report data created to another report number

1. Activate the report window of the report data of which report number will be changed.

2. Choose [Store As] on the Report menu.

3. The [Store As] dialog box appears.

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;New No.&quot;</td>
<td>In the spin box, set the new report number to which the report data on the activated report window will be changed. This may also be done by clicking the display position of the report number to be changed in &quot;Report title&quot;.</td>
</tr>
<tr>
<td>&quot;Old report&quot;</td>
<td>Using the radio buttons, specify whether the report data of the current report number will be deleted or not after the change is made. When the report number setting is complete, click [OK]. The report data moves to the specified report number and the corresponding report window becomes active.</td>
</tr>
</tbody>
</table>
Chapter 10

Downloading / Uploading
10. Downloading/Uploading

10.1 Downloading the Report Project Data

When to use this function?

- When writing the created report project data to the onboard memory of the GOT main unit

Report project data cannot be downloaded from the report software to the GOT main unit. Report project data is downloaded from the graphics software designed for monitor screen data creation.

Use the following procedure to download report project data from the graphics software designed for monitor screen data creation.

Note that the report project data to be downloaded should always be stored in the same directory as that of the monitor screen data stored in the GOT.

(Refer to Section 3.5 "Storing the Report Project Data on Hard Disk or Floppy Disk").

\directory name \a8gotp.got

Must be stored in the same directory.

\report.got

(File name and extension of monitor screen data)

(File name and extension of report project data)

1. Start up the graphic software.

2. Open the monitor screen data having the same directory name as that of the report project data on the graphics software.

3. Choose [Download] ➤ [Monitor Data] on the Communication menu.
4. The [Monitor Data Download] dialog box appears.

![Monitor Data Download dialog box]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Object&quot;</td>
<td>Using the radio buttons, choose the data to be downloaded. All data: Choose this when downloading all data including the report project data. Select data: Choose this when downloading the report project data page by page. You can select the report project data you wish to download. The selected report project data is downloaded.</td>
</tr>
</tbody>
</table>

5. When "Select data" is chosen in "Object", clicking [Report] calls the following screen. Choose the report project data to be downloaded to the GOT.

![Monitor Data Download dialog box with Object No.]

6. Choose [Download]. During downloading, all functions during GOT operation stop.

7. On completion of downloading, the functions being stopped resume automatically.
10.2 Uploading the Report Project Data

When to use this function?

- When reading the report project data written on the onboard memory of the GOT main unit onto the file of the report software


2. The [Monitor Data Upload] dialog box appears.

![Monitor Data Upload dialog box]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Upload destination path&quot;</td>
<td>Specify the drive and bus name of the upload destination.</td>
</tr>
<tr>
<td>&quot;Object&quot;</td>
<td>Using the radio buttons, choose the data of the upload destination.</td>
</tr>
<tr>
<td></td>
<td>Choosing &quot;Select data&quot; and then clicking [Read title] reads the title of the monitor data written on the GOT onboard memory.</td>
</tr>
<tr>
<td>&quot;Password&quot;</td>
<td>When the data transfer password has been set, enter that password.</td>
</tr>
</tbody>
</table>

3. When "Select data" is chosen in "Object" and [Read title] is clicked to read the monitor data from the onboard memory of the GOT, clicking the tab name of the report calls the following screen.

![Monitor Data Upload list]

Specify the report project data to be uploaded.
The specified report project data is uploaded.

During uploading, all functions during GOT operation stop.

4. On completion of uploading, the functions being stopped resume automatically.
Chapter 11

Confirming the Report Project Data
11. Confirming the Report Project Data

11.1 Confirming the Report Project Data Stored on Onboard Memory

When to use this function?

- When confirming the report project data written on the internal memory of the GOT main unit

1. When you choose [Communication] ➤ [Memory] on the graphics software, the following [Communicating] dialog box is displayed and the internal memory information of the GOT main unit is read.

   ![ Communicating Dialog Box]

2. After completion of reading, the [Memory Information] dialog box appears.

   ![ Memory Information Dialog Box]

3. Click the tab name of the report to change the information display data.

   ![ Memory Information Dialog Box]

The report numbers and titles of the reports written on the onboard memory of the GOT main unit are displayed in the Report list.
11.2 Confirming the Report Project Data Stored on Memory Card

When to use this function?
- When confirming the report project data on the IC memory card fitted in the GOT main unit

1. When you choose [Memory Card] on the Communication menu, the following [Communicating] dialog box is displayed and the information stored on the IC memory card fitted in the A870GOT main unit is read.

![Communicating dialog box]

2. After completion of reading, the [Memory Card Information] dialog box appears.

![Memory Card Information dialog box]

3. Click the tab name of the report to change the information display data.

![Memory Card Information dialog box]

The report numbers and titles of the reports existing on the memory card are displayed in the Report list.
WARRANTY

Please confirm the following product warranty details before starting use.

1. Gratis Warranty Term and Gratis Warranty Range
   If any faults or defects (hereinafter "Failure") found to be the responsibility of Mitsubishi occurs during use of the product within the gratis warranty term, the product shall be repaired at no cost via the dealer or Mitsubishi Service Company.
   Note that if repairs are required at a site overseas, on a detached island or remote place, expenses to dispatch an engineer shall be charged for.

[Gratis Warranty Term]
   The gratis warranty term of the product shall be for one year after the date of purchase or delivery to a designated place.
   Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and the longest gratis warranty term after manufacturing shall be eighteen (18) months. The gratis warranty term of repair parts shall not exceed the gratis warranty term before repairs.

[Gratis Warranty Range]
   (1) The range shall be limited to normal use within the usage state, usage methods and usage environment, etc., which follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels on the product.
   (2) Even within the gratis warranty term, repairs shall be charged for in the following cases.
      1. Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused by the user's hardware or software design.
      2. Failure caused by unapproved modifications, etc., to the product by the user.
      3. When the Mitsubishi product is assembled into a user's device. Failure that could have been avoided if functions or structures, judged as necessary in the legal safety measures the user's device is subjected to or as necessary by industry standards, had been provided.
      4. Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designated in the instruction manual had been correctly serviced or replaced.
      5. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force majeure such as earthquakes, lightning, wind and water damage.
      6. Failure caused by reasons unpredictable by scientific technology standards at time of shipment from Mitsubishi.
      7. Any other failure not to be the responsibility of Mitsubishi or the user.

2. Onerous repair term after discontinuation of production
   (1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued.
   Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc.
   (2) Product supply (including repair parts) is not possible after production is discontinued.

3. Overseas service
   Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA Center may differ.

4. Exclusion of chance loss and secondary loss from warranty liability
   Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation to damages caused by any cause found not to be the responsibility of Mitsubishi, chance losses, lost profits incurred to the user by Failures of Mitsubishi products, damages and secondary damages caused from special reasons regardless of Mitsubishi's expectations, compensation for accidents, and compensation for damages to products other than Mitsubishi products and other duties.

5. Changes in product specifications
   The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice.

6. Product application
   (1) In using the Mitsubishi MELSEC programmable logic controller, the usage conditions shall be that the application will not lead to a major accident even if any problem or fault should occur in the programmable logic controller device, and that backup and fail-safe functions are systematically provided outside of the device for any problem or fault.
   (2) The Mitsubishi general-purpose programmable logic controller has been designed and manufactured for applications in general industries, etc. Thus, applications in which the public could be affected such as in nuclear power plants and other power plants operated by respective power companies, and applications in which a special quality assurance system is required, such as for Railway companies or National Defense purposes shall be excluded from the programmable logic controller applications.
   Note that even with these applications, if the user approves that the application is to be limited and a special quality is not required, application shall be possible.
   When considering use in aircraft, medical applications, railways, incineration and fuel devices, manned transport devices, equipment for recreation and amusement, and safety devices, in which human life or assets could be greatly affected and for which a particularly high reliability is required in terms of safety and control system, please consult with Mitsubishi and discuss the required specifications.
<table>
<thead>
<tr>
<th>Model</th>
<th>SW3-A8GOTP-O-RE-E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>1DM178</td>
</tr>
<tr>
<td>Reference</td>
<td>IB(NA)-66795-C(0406)MEE</td>
</tr>
</tbody>
</table>

Specifications subject to change without notice.

When exported from Japan, this manual does not require application to the Ministry of Economy, Trade and Industry for service transaction permission.

Mitsubishi Graphic Operation Terminal